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Name

Background (Area of study, etc.)

Familiarity with R (or other programming languages)
I've heard of R

I've used R

I use R all the time

What about you?

4 / 96

1. A little about R

2. Creating figures with ggplot2

3. Combining figures with patchwork

4. Saving figures

Outline

5 / 96

1. A little about R

2. Creating figures with ggplot2

3. Combining figures with patchwork

4. Saving figures

Taken this or a similar workshop before?

During activities consider...

Extra activities labeled "Too Easy?"

Using your own data

Exploring other aspects of ggplot2 that interest you

Feel free to ask questions even if it's not the "official" activity!

Outline

5 / 96
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What is R?

A programming language is a way to give instructions in order to get a computer to do

something

You need to know the language (i.e., the code)

Computers don't know what you mean, only what you type (unfortunately)

Spelling, punctuation, and capitalization all matter!

For example

R, what is 56 times 5.8?

56 * 5.8

## [1] 324.8

R is Programming language

7 / 96

R, what is the average of numbers 1, 2, 3, 4?

mean(c(1, 2, 3, 4))

## [1] 2.5

Use code to tell R what to do

8 / 96
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R, what is the average of numbers 1, 2, 3, 4?

mean(c(1, 2, 3, 4))

## [1] 2.5

R, save this value for later

steffis_mean <- mean(c(1, 2, 3, 4))

Use code to tell R what to do

8 / 96

R, what is the average of numbers 1, 2, 3, 4?

mean(c(1, 2, 3, 4))

## [1] 2.5

R, save this value for later

steffis_mean <- mean(c(1, 2, 3, 4))

R, multiply this value by 6

steffis_mean * 6

## [1] 15

Use code to tell R what to do

8 / 96

R is hard

Why R?

9 / 96
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But R is powerful (and reproducible)!

Why R?

10 / 96

But R is powerful (and reproducible)!

Why R?

(I made these slides with Rmarkdown) 10 / 96

R is also beautiful

Why R?

11 / 96
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R is affordable (i.e., free!)

Why R?

12 / 96

ImpostR Syndrome

13 / 96

ImpostR Syndrome

David Whittaker

14 / 96
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ImpostR Syndrome

David Whittaker

Moral of the story? 
Make friends, code in groups, learn together and don't beat yourself up

14 / 96

@allison_horst 15 / 96

About R
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Code

The actual commands

Output

The result of running code or a script

Script

A text file full of code that you want to run

You should always keep your code in a script

Code, Output, Scripts

17 / 96

Code

The actual commands

Output

The result of running code or a script

Script

A text file full of code that you want to run

You should always keep your code in a script

For example:

mean(c(1, 2, 3, 4))

## [1] 2.5

Code, Output, Scripts

Code

Output

Script

17 / 96

RStudio is not R

RStudio is a User Interface or IDE (integrated development environment)
(i.e., Makes coding simpler)

RStudio vs. R

RStudio
R

18 / 96
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mean(), read_csv(), ggplot(), c(), etc.

functions() - Do things, Return things

19 / 96

mean(), read_csv(), ggplot(), c(), etc.

Always have ()
Can take arguments (think 'options')

mean(x = c(2, 10, 45)),

mean(x = c(NA, 10, 2, 65), na.rm = TRUE)

functions() - Do things, Return things

19 / 96

By name:
mean(x = c(1, 5, 10))

## [1] 5.333333

By position:
mean(c(1, 5, 10))

## [1] 5.333333

mean(), read_csv(), ggplot(), c(), etc.

Always have ()
Can take arguments (think 'options')

mean(x = c(2, 10, 45)),

mean(x = c(NA, 10, 2, 65), na.rm = TRUE)

Arguments defined by name or by position

With correct position, do not need to specify by name

functions() - Do things, Return things

19 / 96
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?mean

R documentation

20 / 96

?mean

R documentation

20 / 96

Vector (1 dimension)
my_data <- c("a", 100, "c")
my_data

## [1] "a"   "100" "c"

Data frame (2 dimensions)
my_data <- data.frame(site = c("s1", "s2", "s3"),
                      count = c(101, 102, 103),
                      treatment = c("a", "b", "c"))
my_data

##   site count treatment
## 1   s1   101         a
## 2   s2   102         b
## 3   s3   103         c

Generally kept in vectors or data.frames
These are objects with names (like functions)

We can use <- to assign values to objects (assignment)

Data

rows x
columns

21 / 96
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Your first real code!

# First load the packages 
library(palmerpenguins) 
library(ggplot2) 

# Now create the figure 
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) + 
  geom_point()

Copy/paste or type this into the script window in RStudio
You may have to go to File > New File > R Script

Click anywhere on the first line of code

Use the 'Run' button to run this code, or use the short-cut Ctrl-Enter
Repeat until all the code has run

First Code

23 / 96

# First load the packages 
library(palmerpenguins) 
library(ggplot2) 

# Now create the figure 
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) + 
  geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).

First Code

24 / 96
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# First load the packages 
library(palmerpenguins) 
library(ggplot2) 

# Now create the figure 
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) + 
  geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).

First Code

Packages 
ggplot2 and palmerpenguins

25 / 96

# First load the packages 
library(palmerpenguins) 
library(ggplot2) 

# Now create the figure 
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) + 
  geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).

First Code

Functions: 
library(), ggplot() 

aes(), and geom_point()

26 / 96

# First load the packages 
library(palmerpenguins) 
library(ggplot2) 

# Now create the figure 
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) + 
  geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).

First Code

+ 
(Specific to ggplot2)

27 / 96
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# First load the packages 
library(palmerpenguins) 
library(ggplot2) 

# Now create the figure 
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) + 
  geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).

First Code

Figure!

28 / 96

# First load the packages 
library(palmerpenguins) 
library(ggplot2) 

# Now create the figure 
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) + 
  geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).

First Code

Warning

29 / 96

# First load the packages 
library(palmerpenguins) 
library(ggplot2) 

# Now create the figure 
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) + 
  geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).

First Code

Comments

30 / 96
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Let's get started

Now you know R!

Our data set: Palmer Penguins!

Artwork by @allison_horst 32 / 96

library(palmerpenguins)
penguins

## # A tibble: 344 x 8
##    species island    bill_length_mm bill_depth_mm flipper_length_mm body_mass_g sex     year
##    <fct>   <fct>              <dbl>         <dbl>             <int>       <int> <fct>  <int>
##  1 Adelie  Torgersen           39.1          18.7               181        3750 male    2007
##  2 Adelie  Torgersen           39.5          17.4               186        3800 female  2007
##  3 Adelie  Torgersen           40.3          18                 195        3250 female  2007
##  4 Adelie  Torgersen           NA            NA                  NA          NA <NA>    2007
##  5 Adelie  Torgersen           36.7          19.3               193        3450 female  2007
##  6 Adelie  Torgersen           39.3          20.6               190        3650 male    2007
##  7 Adelie  Torgersen           38.9          17.8               181        3625 female  2007
##  8 Adelie  Torgersen           39.2          19.6               195        4675 male    2007
##  9 Adelie  Torgersen           34.1          18.1               193        3475 <NA>    2007
## 10 Adelie  Torgersen           42            20.2               190        4250 <NA>    2007
## # … with 334 more rows

Our data set: Palmer Penguins!

Artwork by @allison_horst 33 / 96
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library(palmerpenguins)
penguins

## # A tibble: 344 x 8
##    species island    bill_length_mm bill_depth_mm flipper_length_mm body_mass_g sex     year
##    <fct>   <fct>              <dbl>         <dbl>             <int>       <int> <fct>  <int>
##  1 Adelie  Torgersen           39.1          18.7               181        3750 male    2007
##  2 Adelie  Torgersen           39.5          17.4               186        3800 female  2007
##  3 Adelie  Torgersen           40.3          18                 195        3250 female  2007
##  4 Adelie  Torgersen           NA            NA                  NA          NA <NA>    2007
##  5 Adelie  Torgersen           36.7          19.3               193        3450 female  2007
##  6 Adelie  Torgersen           39.3          20.6               190        3650 male    2007
##  7 Adelie  Torgersen           38.9          17.8               181        3625 female  2007
##  8 Adelie  Torgersen           39.2          19.6               195        4675 male    2007
##  9 Adelie  Torgersen           34.1          18.1               193        3475 <NA>    2007
## 10 Adelie  Torgersen           42            20.2               190        4250 <NA>    2007
## # … with 334 more rows

Your turn! Run this code and look at the output in the console

Our data set: Palmer Penguins!

Artwork by @allison_horst 33 / 96

library(palmerpenguins) 
library(ggplot2) 

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) + 
    geom_point()

A basic plot

34 / 96

library(palmerpenguins) 
library(ggplot2) 

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) + 
   geom_point()

library(palmerpenguins)
Load the palmerguins package so we have access to penguins data

Break it down

35 / 96
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library(palmerpenguins) 
library(ggplot2) 

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) + 
   geom_point()

library(ggplot2)
Load the ggplot2 package (which gives us access to the ggplot() function among others)

Break it down

36 / 96

library(palmerpenguins) 
library(ggplot2) 

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) + 
   geom_point()

ggplot()
Set the attributes of your plot

data = Dataset

aes = Aesthetics (how the data are used)

Think of this as your plot defaults

Break it down

37 / 96

library(palmerpenguins) 
library(ggplot2) 

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) + 
   geom_point()

geom_point()
Choose a geom function to display the data

Always added to a ggplot() call with +

ggplots are essentially layered objects, starting with a call to ggplot()

Break it down

38 / 96
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ggplot(data = penguins, aes(x = sex, y = body_mass_g)) ggplot(data = penguins, aes(x = sex, y = body_mass_g)) +
  geom_boxplot()

Plots are layered

39 / 96

ggplot(data = penguins, aes(x = sex, y = body_mass_g)) ggplot(data = penguins, aes(x = sex, y = body_mass_g)) +
  geom_point()

Plots are layered

40 / 96

ggplot(data = penguins, aes(x = sex, y = body_mass_g)) ggplot(data = penguins, aes(x = sex, y = body_mass_g)) +
  geom_violin()

Plots are layered

41 / 96
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You can add multiple layers
ggplot(data = penguins, aes(x = sex, y = body_mass_g)) +
  geom_boxplot()

Plots are layered

42 / 96

You can add multiple layers
ggplot(data = penguins, aes(x = sex, y = body_mass_g)) +
  geom_boxplot() + 
  geom_point(size = 2, colour = "red")

Plots are layered

43 / 96

You can add multiple layers
ggplot(data = penguins, aes(x = sex, y = body_mass_g)) +
  geom_boxplot() + 
  geom_point(size = 2, colour = "red")

Order matters
ggplot(data = penguins, aes(x = sex, y = body_mass_g)) +
  geom_point(size = 2, colour = "red") +
  geom_boxplot()

Plots are layered

43 / 96
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Any ggplot can be saved as an object
g <- ggplot(data = penguins, aes(x = sex, y = body_mass_g))

Plots are objects

44 / 96

g

Any ggplot can be saved as an object
g <- ggplot(data = penguins, aes(x = sex, y = body_mass_g))

Plots are objects

44 / 96

g g + geom_boxplot()

Any ggplot can be saved as an object
g <- ggplot(data = penguins, aes(x = sex, y = body_mass_g))

Plots are objects

44 / 96
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(Plot types)

More Geoms

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +
  geom_line()

Geoms: Lines

46 / 96

ggplot(data = penguins, aes(x = body_mass_g)) +
  geom_histogram(binwidth = 100)

Geoms: Histogram

47 / 96
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ggplot(data = penguins, aes(x = body_mass_g)) +
  geom_histogram(binwidth = 100)

Geoms: Histogram

Note: We only need 1
aesthetic here (x)

47 / 96

Let ggplot count your data
ggplot(data = penguins, aes(x = sex)) +
  geom_bar()

Geoms: Barplots

48 / 96

You can also provide the counts
# Create our own data frame
species <- data.frame(species = c("Adelie", "Chinstrap", "Gentoo"),  
                      n = c(152, 68, 124))

ggplot(data = species, aes(x = species, y = n)) +
  geom_bar(stat = "identity")

Geoms: Barplots

49 / 96
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library(ggplot2) 

ggplot(data =        , aes(x =      , y =             )) + 
  geom_       (               )

Your Turn: Create this plot

50 / 96

Showing data by group

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +
  geom_point()

Mapping aesthetics

52 / 96
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ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = sex)) + 
  geom_point()

Mapping aesthetics

53 / 96

ggplot automatically populates the legends (combining where it can)
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = sex, shape = sex)) +
  geom_point()

Mapping aesthetics

54 / 96

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = sex)) +
  geom_point() +
  facet_wrap(~ species)

Faceting: facet_wrap()

Split plots by one
grouping variable

55 / 96
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ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = sex)) +
  geom_point() +
  facet_grid(sex ~ species)

Faceting: facet_grid()

Split plots by two
grouping variables

56 / 96

ggplot(data =        , aes(                                          )) +  
                 +                                                       
                       

Hint: colour is for outlining with a colour, fill is for 'filling' with a colour

Too Easy? Split boxplots by sex and island

Your Turn: Create this plot

57 / 96

Trendlines / Regression Lines
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geom_line() is connect-the-dots, not a trend or linear model
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +
  geom_point() +
  geom_line()

Trendlines / Regression lines

59 / 96

geom_line() is connect-the-dots, not a trend or linear model
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +
  geom_point() +
  geom_line()

Trendlines / Regression lines

Not what we're
looking for

59 / 96

Let's add a trend line properly
Start with basic plot:

g <- ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +
  geom_point()
g

Trendlines / Regression lines

60 / 96
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Add the stat_smooth()
lm is for "linear model" (i.e. trendline)

grey ribbon = standard error

g + stat_smooth(method = "lm")

Trendlines / Regression lines

61 / 96

Add the stat_smooth()
remove the grey ribbon se = FALSE

g + stat_smooth(method = "lm", se = FALSE)

Trendlines / Regression lines

62 / 96

A line for each group
Specify group (here we use colour to specify species)

g <- ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +
  geom_point()
g

Trendlines / Regression lines

63 / 96
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A line for each group
stat_smooth() automatically uses the same grouping

g + stat_smooth(method = "lm", se = FALSE)

Trendlines / Regression lines

64 / 96

A line for each group AND overall
g +  
  stat_smooth(method = "lm", se = FALSE) + 
  stat_smooth(method = "lm", se = FALSE, colour = "black")

Trendlines / Regression lines

65 / 96

A scatter plot: Flipper Length by Body Mass grouped by Species

With a single regression line for the overall trend

Too Easy? Create a separate plot for each sex as well

Your Turn: Create this plot

66 / 96
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Customizing plots

Let's work with this plot
g <- ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +
  geom_point()

Customizing: Starting plot

68 / 96

g + labs(title = "Bill Length vs. Body Mass", 
         x = "Body Mass (g)", 
         y = "Bill Length (mm)",
         colour = "Species", tag = "A")

Customizing: Labels

69 / 96
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g + labs(title = "Bill Length vs. Body Mass", 
         x = "Body Mass (g)", 
         y = "Bill Length (mm)",
         colour = "Species", tag = "A")

Customizing: Labels

Practice for later 
Add proper labels to some of your

previous plots

69 / 96

Customizing: Built-in themes

70 / 96

scale_ + (x or y) + type (contiuous, discrete, date, datetime)

scale_x_continuous()
scale_y_discrete()
etc.

Common arguments
g + scale_x_continuous(breaks = seq(0, 20, 10)) # Tick breaks
g + scale_x_continuous(limits = c(0, 15))       # xlim() is a shortcut for this
g + scale_x_continuous(expand = c(0, 0))        # Space between axis and data

Customizing: Axes

71 / 96
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Breaks
g + scale_x_continuous(breaks = seq(2500, 6500, 500))

Customizing: Axes

72 / 96

Limits
g + scale_x_continuous(limits = c(3000, 4000))

Customizing: Axes

73 / 96

Space between origin and axis start
g + scale_x_continuous(expand = c(0, 0))

Customizing: Axes

74 / 96

30



Using scales
scale_ + aesthetic (colour, fill, size, etc.) + type (manual, continuous, datetime, etc.)

g + scale_colour_manual(name = "Type", values = c("green", "purple", "yellow"))

Customizing: Aesthetics

75 / 96

Using scales
Or be very explicit:

g + scale_colour_manual(name = "Type", 
                        values = c("Adelie" = "green", "Gentoo" = "purple", "Chinstrap" = "yellow"), 
                        na.value = "black")

Customizing: Aesthetics

76 / 96

For colours, consider colour-blind-friendly scale
viridis_d for "discrete" data

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) + 
  geom_point() +  
  scale_colour_viridis_d(name = "Type")

Customizing: Aesthetics

77 / 96
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For colours, consider colour-blind-friendly scale
viridis_c for "continuous" data

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = flipper_length_mm)) + 
  geom_point() +  
  scale_colour_viridis_c(name = "Flipper Length (mm)")

Customizing: Aesthetics

78 / 96

Forcing
Remove the association between a variable and an aesthetic

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = sex)) + 
  geom_point(colour = "green", size = 5) + 
  stat_smooth(method = "lm", se = FALSE, colour = "red")

Customizing: Aesthetics

Note: When forcing,
aesthetic is not
inside aes()

79 / 96

At the: top, bottom, left, right
g + theme(legend.position = "top")

Exactly here
g + theme(legend.position = c(0.15, 0.7))

Customizing: Legends placement

80 / 96
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Combining plots

Setup
Load patchwork
Create a couple of different plots

library(patchwork)

g1 <- ggplot(data = penguins, aes(x = bill_length_mm, y = bill_depth_mm, colour = species)) + 
  geom_point()

g2 <- ggplot(data = penguins, aes(x = species, y = flipper_length_mm)) + 
  geom_boxplot()

g3 <- ggplot(data = penguins, aes(x = flipper_length_mm, y = body_mass_g, colour = species)) + 
  geom_point()

Combining plots with patchwork

82 / 96

Side-by-Side 2 plots
g1 + g2

Combining plots with patchwork

83 / 96
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Side-by-Side 3 plots
g1 + g2 + g3

Combining plots with patchwork

84 / 96

Stacked 2 plots
g1 / g2

Combining plots with patchwork

85 / 96

More complex arrangements
g2 + (g1 / g3)

Combining plots with patchwork

86 / 96
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More complex arrangements
g2 / (g1 + g3)

Combining plots with patchwork

87 / 96

"collect" common legends
g2 / (g1 + g3) + plot_layout(guides = "collect")

Combining plots with patchwork

88 / 96

"collect" common legends
g2 / (g1 + g3 + plot_layout(guides = "collect"))

Combining plots with patchwork

89 / 96
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Annotate
g2 / (g1 + g3) + 
  plot_layout(guides = "collect") +
  plot_annotation(title = "Penguins Data Summary",          
                  caption = "Fig 1. Penguins Data Summary", 
                  tag_levels = "A",                         
                  tag_suffix = ")")

Combining plots with patchwork

90 / 96

Saving plots

RStudio Export
Demo

Saving plots

92 / 96
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RStudio Export
Demo

ggsave()
g <- ggplot(penguins, aes(x = sex, y = bill_length_mm, fill = year)) +
  geom_boxplot()

ggsave(filename = "penguins_mass.png", plot = g)

## Saving 8 x 3.6 in image

Saving plots

92 / 96

Publication quality plots
Many publications require 'lossless' (pdf, svg, eps, ps) or high quality formats (tiff, png)

Specific sizes corresponding to columns widths

Minimum resolutions

g <- ggplot(penguins, aes(x = sex, y = body_mass_g)) +
  geom_boxplot() +
  labs(x = "Sex", y = "Body Mass (g)") + 
  theme(axis.text.x = element_text(angle = 45, hjust = 1))

ggsave(filename = "penguins_mass.pdf", plot = g, dpi = 300,
       height = 80, width = 129, units = "mm")

Saving plots

93 / 96

The package is ggplot2, the function is just ggplot()
Did you remember to put the + at the end of the line?

Order matters! If you're using custom theme()'s, make sure you put these lines after bundled

themes like theme_bw(), or they will be overwritten

Variables like 'year' are treated as continuous, but are really categories
Wrap them in factor(), i.e. ggplot(data = penguins, aes(x = factor(year), y =
body_mass_g))

Wrapping up: Common mistakes

94 / 96
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RStudio > Help > Cheatsheets > Data Visualization with ggplot2

ggplot2 book v3
By Hadley Wickham, Danielle Navarro, and Thomas Lin Pedersen

Cookbook for R - by Winston Chang

See also R Graphics Cookbook by Winston Chang

R for Data Science

Data Visualization

Wrapping up: Further reading (all Free!)

95 / 96

Create a figure with...
Custom colour mapping (i.e. scales_....)

Clear, human-readable labels

More than one graph, each one tagged (e.g., A) or B))

With more than one geom type

At least one scatterplot with regression line

:D

OR... Load your own data and create a figure of your own!

Your Turn!

96 / 96
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